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Introduction

g	 1.1	 Welcome

Welcome to Smart Connection for InCopy, a prom¬inent member of 
WoodWing’s Smart Publishing Team.
Smart Connection is a powerful workflow solution aimed at publishing 
environments where Adobe InDesign and InCopy drive production. Smart 
Connection allows designers to work on a layout while editors write con-tent—
simultaneously. One can even assign different stories from one page to separate 
editors. Editors have the ability to see how their copy will rest on the designed 
page. Smart Connection’s easy-to-use interface is one of its much appreciated 
features, while its open architec-ture allows quick and flexible integration with 
a variety of platforms and systems.

The features that Smart Connection adds to your version of InCopy are 
numerous and contain many different options. This chapter highlights all the 
areas of InCopy that have changed by the installa¬tion of Smart Connection; 
the chapters following this chapter will cover each option in more detail.

g	 1.2	 Permissions

It is important to know that your administrator can con¬trol some of your 
basic InCopy functionality—as well as restrict the availability or functionality 
of certain Smart Connection options—when working on documents that are 
stored in Enterprise. This is done by using Access Profiles which are associated 
with your user account. It may therefore be that you will not be able to use 

certain InCopy features such as applying character styles or paragraph styles, 
selecting fonts or font styles, editing Sticky Notes, etc. when working on files that 
are stored in Enterprise.
configured Smart Connection for you so you should be ready to start Smart 
Connection in InCopy straight away.

The purpose of controlling certain functionality this way is to guarantee the 
content of the layout or article and to pre¬vent any changes that don’t conform to 
the Brand style. Restrictions can also be linked to a particular Workflow Status, 
so it may be that access to Smart Connection features changes depending on the 
status that a layout or article is in.

This all means that you may come across options in this User Guide that you may 
find you don’t always have access to. Wherever an option is described that can be 
limited by an Access Profile setting, this will be indicated by an icon.
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g	 2.1	 Quick Start overview

Before getting to grips with all the many features of Smart Connection, you 
may first want to know how to get started with the product for every day use. 
This chapter does just that: it will guide you through some of the most often 
used tasks when using Smart Connection in InCopy. Once you know your way 
around the product, you can learn more about each feature by reading through 
the rest of the User Guide.

The following tasks are covered in this chapter:
1.	 Logging In
2.	 The Smart Connection panel 
3.	 Searching for files
4.	 Creating an article
5.	 Checking out an article
6.	 Closing an article
7.	 Logging out

g	 2.2	L ogging In

Step 1: From the Smart Connection menu choose the Login option 
(�). The Login dialogue will appear (�) (see figure 1)

Step 2: From the Login dialogue, select the Entrprise Server name 
from the list provided.

Step 3: Enter your Username & Password to complete the login.

Quick Start2

�

�

Figure 1
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Smart Connection - Quick Start

g	 2.4	S earching for content

Step 1: From the Search menu (�) select Browse.
Step 2: Make further selection from the Lists (����) provided
Step 3: Locate the document or article in the results pane (�) and 
double-click on it to open the object.
Step4: Use the Refresh (�) icon to refresh the results to show changes.

g	 2.3 	T he Smart Connection Panel

Once the user has successfully logged into the system then the Smart 
Connection Panel will appear (See figure 2). 
If this is the first time you have logged in and the Smart Connection Panel does 
not appear, then this can be activated from the Windows menu, choose the 
Smart Connection/ Smart Connection menu from the list provided.
The Smart Connection panel is your main access to all the files stored in the 
Enterprise system. You will use it mainly to search for files by using one of its 
many search modes.
Once you have found the file you are looking for, it can be opened (in case of 
layouts and Layout Modules) or placed on the layout (in case of articles, Layout 
Modules, and images).

When opening a layout, it is checked out of the system. This means that 
other users cannot make any changes to the layout. This is indicated by the 
appearance of a pencil icon ( )  ) that appears for the file in the In Use 

By column of the Document pane in your Smart Connection panel. For all other 
users, a padlock icon ( ) appears for that file.

�

�

��

�

�  Search lists   �  Document pane   �  Flyout menu    �  Preview pane    
�  Status bar

Figure 2

�

�
�

�

�

�
�

�  Search menu   �  Publication list   �  Issue list   �  Section list   �  
Status list   �  Results/Document pane   �  Refresh/Search icon

Figure 3
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Smart Connection - Quick Start

g	 2.5	C hecking-out an article

Before being able to edit an article that is saved in Enterprise, it needs to be 
checked out. Checking out an article ensures that no other user can make 
changes to the content of that article while you are working on the file. To 
check out an article, do the following:

Step 1. In the Smart Connection panel, locate the article that you 
want to edit.
Step 2. Do one of the following:

nn Double-click the article/object
nn Right-click the article/object  and choose Open from the context 

menu 
 .
When viewing the article in Layout View , you will be able to see the layout 
that the article is placed on. All articles that you have not checked out, or are 
not available to you, will appear dimmed. (See figure 4)

When viewing the article in Story view or Galley view, you will see only the 
text of the article, along with the relavant styling, but no graphics. Figure 4 - Layout View
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Smart Connection - Quick Start

nn Check In -  Saves the article and closes it, making it available to other 
users for editing. A dialog box appears (�) for entering the required 
information. 

nn Abort Check Out -  Closes the article without saving any made changes. 
The article will be available to other users for editing. 

nn Close for Offline Usage -  Saves the file locally on your system so that 
it can be edited without being connected to Enterprise. The file stays 
unavailable to other users for editing.

                  

g	 2.6	C hecking-in an article

Various methods exist for saving and/or checking-in the article, all available 
through the Smart Connection menu (�)

nn Save Article Version -  Saves an intermediate version of the article. 
A dialog box appears (�)for entering the required information. The 
original article stays open for editing. 

nn Save As - Saves a copy of the article. A dialog box appears (�) for 
entering the required information. The original article stays open for 
editing. 

�

Figure 5
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Smart Connection - Quick Start

g	 2.7	L ogging Out

When finished working in InCopy, don’t forget to log out of the Enterprise 
system. This makes sure that any panel settings are saved to the system so that 
you can make use of these settings when next logging in, even when logging in 
from another system.

nn From the Smart Connection menu (�) select Log Out 

After logging out, the Smart Connection panel (�) will appear in Offline 
mode, showing all files that you have taken offline.
Note: Offline files can be edited without being logged into Enterprise.

�

Figure 6

Figure 7
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g	 3.3	 Panel Components

The Smart Connection panel consists of the following components: (see figure 8)

nn Search pane. (�) The Search pane is used for specifying criteria in 
order to locate files that are stored in the Enterprise system. Its main 
component is the Search menu from which various modes can be 
chosen. Depending on the chosen mode, additional lists and/or entry 
boxes appear from which criteria can be selected or entered in order to 
further specify the search criteria. The results are subsequently shown in 
the Documents/Results pane. The Refresh button can be used to update 
the Documents/Results pane when needed. 

nn Documents/Results  pane. (�) Displays all files found based on the 
criteria specified in the Search pane. 

nn Preview pane. (�) When selecting a file in the Document pane, the 
Preview pane will display a preview of that file. 

nn Status bar. (�) Displays log-in information and information about the 
total number of files found. 

nn Flyout menu. (�) Contains commands for changing the way files are 
displayed in the panel and for creating additional panels.

Each component is described in detail in the following sections (see figure 8).

g	 3.1	S mart Connection Panel overview

When using Smart Connection in InCopy, the Smart Connection panel is your 
main link to the files stored in the Enterprise database and will therefore be the 
panel that you will use most often.

Via this panel, you can locate files stored in the Enterprise system and 
subsequently manage them in many ways: open articles (layouts), edit or place 
files on the layout, route files to other users, and much more. 

This chapter covers each panel option in detail.

g	 3.2	A ccessing the panel

The Smart Connection panel displays automatically after signing in to 
Enterprise, but can also be accessed by choosing Smart Connection from the 
Smart Connection submenu of the Window menu.

By default, the panel opens in Inbox mode when first using Smart Connection, 
showing all files that have been routed to you by other users. 

Each time you log off from Enterprise, the display settings for the Smart 
Connection panel are stored on the server, meaning that when you next log 
ineven when using a different system the settings will be loaded that were last 
saved to the server.

3 Using the Smart Connection Panel
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nn Changing columns. (List View mode only) Add or remove columns or 
arrange them in a different order. 

nn Sorting. (List View mode only) Sort columns either individually or by 
group. 

nn Font size. (List View mode only) Change the size of the displayed text. 

Each option is described in the following sections.

The Documents/Results pane in List View mode (Figure 9)

g	 3.4.1	V iew Modes

The Document pane can be displayed in two different view modes: List View 
(default setting) and Thumbnail View. Each mode can be selected from the 
panel’s flyout menu: 

nn Show as List. List view mode. 

nn Show as Thumbnails. Thumbnail view mode

g	 3.4	T he Documents/Results pane

After setting criteria in the Search pane, the resulting files are subsequently 
displayed in the Document/Results pane.

The Document/Results pane is your central area for managing files such as 
adding them to a Dossier, routing them to a user or user group, removing them 
from the system, and more.

The way that the files are displayed can be fully customized to suit your 
workflow by changing any of the following:

nn View mode. View the results in List View or Thumbnail View. 

nn Hierarchical view. (List View mode only) Display files that have 
embedded content (such as layouts with placed articles, Layout 
Modules or images) as a group.

Using The Smart Connection Panel

�

�

��

�

�  Search lists   �  Document pane   �  Flyout menu    �  Preview pane    
�  Status bar

Figure 8
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Placed On Name of the layout that the item has been placed. Only 
applies to articles and images

The following table shows the columns that are hidden by default.
Column Description

Type File type by name such as, layout, image, article etc.

Placed on page Document page number(s) onto which the file is placed

Deadline Colour of the Deadline that the file is on

Size File size displayed in Gb, Mb or Kb

Word Count (Articles only) Total number of words in an article

Character count (Articles only) Total number of characters in the article

Line Count (Articles only) Total number of lines in the article

Comment Comment associated with the file

Slugline (Text files only) shows first 250 characters

Page Range Page numbering range

Planned Page 
range

Shows the planned page range that is provided by the 
Planning tool, Media Planner.

Brand Name of the Publication/Brand of which the file is part

Category/Section Name of the Category/Section of which the file is part

Issue Name of the Issue that the file is part and is used in

Created By Name of the user that created/uploaded the file

g	 3.4.2	L ist View Mode

The List view mode is the default mode of the Document /Results pane and 
displays the documents in a tabular form; each document is displayed on its 
own row with information pertaining to that document displayed in multiple 
columns (see figure 9).

Initially, only a limited number of columns are displayed but columns that are 
hidden from view can be easily displayed at any stage. (For more information 
about hiding or showing columns, see section Showing or Hiding Columns 
later in this section.)

The following table shows the columns displayed by default:
Column Description

Type (Icon) Icon designates the type of file (see icons list figure 10)

Status (Icon) Colour of the worklflow status that the file is in.

In Use By (Icon) Indicated if the file is checked-out by user or not (see 
figure 11)

Name Name of the file

Status Workflow Status that the file is in

Route to Name of the user that the file is routed to

In Use By Name of the user that has Checked out the file

Modified By Name of the last user to have modified the file

Modified On The Date when the file was last modified 

Using The Smart Connection Panel
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g	 3.4.3	T humbnail View Mode

With the Document pane in Thumbnail View mode, a preview is displayed of 
each file, showing what the content of that file looks like. This can be especially 
handy when viewing layouts or images. Below each preview, the file name is 
listed.

A thumbnail is not shown for:
nn Articles or text files
nn Audio, video, and Flash files
nn Graphic files such as .AI, .EPS, and .PDF files
nn Dossiers and libraries
nn Files for which a preview has not been generated (yet)

g	 3.4.4	H ierarchical view mode 

The Hierarchical View groups together files with their embedded content, such 
as layouts with placed items articles, Layout Modules, or images as well as articles 
consisting of multiple components. This is very similar to the List View.

Figure 10 - Shows Type Icons

Type Icon Description

Article InCopy

Article HTML text

Article Plain text

a Ms Word Document

Dossier

InDesign layout

Video

Images

 Audio

Figure 11 - Shows the InUse Icons

In Use By Icon Description

Yellow Pencil: The current user has the file open or 
checked-out, or has the files Properties dialogue 
open

Yellow Padlock: Another user has the file open 
check-out, or has the files Properties dialogue open.
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Step 2. Do one of the following:
nn Drag the divider to the left to make the column narrower.
nn Drag the divider to the right to make the column wider.

g	 3.5.2	S how or Hide columns

To show or hide a column:

Step 1. Ctrl-click (Mac OS) or Right-click (Windows) a column header. 
The column that is going to be added appears to the right of this 
column.
A context menu appears showing all available columns. Columns that 
are currently visible have a check mark in front of their name, columns 
that are currently hidden do not have such a check mark.

Step 2. Click on a column name.
The context menu disappears. If the column was previously hidden, 
it will be displayed; if the column was previously displayed, it will be 
hidden.

Step 3. (Optional) Repeat Steps 1 and 2 until all columns are displayed 
or hidden as needed. 

The order of the columns in the context menu is determined by the 
order in which the columns are rearranged.

g	 3.5.3	R earrange Columns

To rearrange columns in a different order, do the following:

Step 1. Drag the header of the column that needs to be moved to 
another location over the column divider between the two columns 
where you want the column to be placed.

g	 3.5	C hanging Columns in Documents/Results pane

When in List View mode, the view of the displayed columns can be changed in 
the following ways:

nn Columns can be made wider or narrower
nn Columns can be hidden or displayed
nn Columns can be rearranged
nn Columns can be sorted
nn The font size can be changed

Each option is described in detail in the following sections.

g	 3.5.1	C hanging Column Widths

To change the width of a column, do the following:

Step 1. Place the mouse pointer over the column divider to the right 
of the column of which the width needs to be changed.
The mouse pointer changes into an arrow pointing left and right .
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g	 3.5.5	I cons

Column Icon Description

In Use By

Yellow pencil - You have the file opened for 
editing or have opened the Properties dialogue 
box for that file

Red pencil - You have taken the file Offline

Yellow Padlock - Another user is editing file or 
has opened the Properties dialogue box of that 
file.

Red Padlock - Another user has taken the file 
Offline

Brown Flag - An update from the Planning tool, 
Media Planner, is available.

Hierarchical 
View

Chain/Link icon - Shows components of any 
placed article

Deadline 
Icons

Gray - Object has no Deadline
Green  - Object is well whithin Deadline
Yellow - Object is nearing its Deadline
Red - Object has passed its Deadline 

The mouse pointer turns into a fist and the column divider is 
displayed in red.

Step 2. Release the mouse button. 
The column is moved to its new position.

g	 3.5.4	S orting Columns

Columns can be sorted in ascending or descending order either individually or 
combined by doing the following:

Sorting individually. Click once on any column header. If the 
column was previously not sorted, it will be sorted in descending 
order. Any subsequent clicks will sort the list in the opposite direction. 
The order is shown by means of a black triangle pointing up or down 
next to the column header name. 

Sorting multiple columns. To sort the list according to the criteria of 
multiple columns, click once on the first column header and Shift-
click each subsequent column header. The columns will be sorted in 
the order they are clicked. A hollow triangle pointing up or down is 
shown next to the column header name. Multiple column sorting can 
be disabled by single clicking any column. 
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Dynamic Update is active in all views with the exception of the Thumbnail view 
and certain Search modes. When the dynamic update feature is not active, the 
icon will be dimmed( .)

As the update occurs, you automatically see status changes, for instance if a file is 
checked out. 

g	 3.6.2	M anual Refresh

The panel content can be refreshed manually by using either the Refresh button 
or the Refresh command in the panel flyout menu.

Using Refresh will perform the following actions: 

nn Deleted files will be removed.
nn Newly added items that were placed at the top of the list and displayed 

in bold are sorted according to the sorting rules set and presented 
regularly.

nn Changed items that were displayed in italic are presented regularly.
nn Hierarchy View will become available for newly added files.
nn After making a selection in one of the Search lists, the Document pane 

will be populated with the results.

g	 3.5.6	T ext Formatting

For any changes to the state of a file such as changing the properties of a file 
in its Properties dialog box the formatting of the text itself is changed for that 
particular file:

Bold. Newly added files are placed at the top of the list and displayed 
in bold font style. When using the Refresh option, the entries will be 
displayed in normal style and sorted according to the column sorting 
order.

Italic. Files for which the properties have changed are shown in 
italic. When using the Refresh option, the entries will be displayed in 
normal style.

g	 3.6	U pdating the Document/results pane

Updating the content of the Document pane is mostly done automatically by 
means of the Dynamic Update feature. Under certain circumstances however, 
this needs to be done manually.

g	 3.6.1 	Dynamic Update

The content of the Smart Connection panel is automatically updated by means 
of the Dynamic Update option as indicated by the Dynamic Update Icon in the 
status bar of the panel.

 �
                     

Dynamic
Update
Icon
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� Resize control bar      �  Preview area

Figure 10 - The preview pane shows a preview of the selected file

g	 3.7	T he Preview pane

When selecting a file in the Document pane, the Preview pane displays a 
preview of that file. If no preview is available (for instance when no thumbnails 
were saved with a layout or image), the application icon is shown. For text files, 
the first 250 characters are displayed.

To display or hide the Preview pane, choose Show Preview or Hide Preview 
respectively from the panel flyout menu. (see figure 10)

The size of displayed text (when previewing an article) can be controlled by a 
preference. 

The size of the Preview itself can be controlled by reducing or increasing the 
size of the Preview pane. 

To change the size of the Preview area, do the following:
Step 1. Place the mouse pointer over the Resize Control Bar between 
the Document pane and the Preview pane.  
 
When doing so, the cursor will change to a double-headed arrow.

Step 2. Drag the Resize Control Bar up or down to resize the preview 
area as required.
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(Figure 11)
�  �                 �  �

� - Dynamic icon  � - Enterprise Server name  � - Search Results   
� - Navigation buttons

g	 3.9	F lyout menu

The Flyout menu of the Smart Connection panel gives you access to 10 additional 
commands:

Show as List
Displays the Document pane in List view mode; each document is 
displayed on its own row with information pertaining to that document 
displayed in multiple columns.

Show as Thumbnails
Displays the Document pane in Thumbnail view mode; each document 
is shown as a small preview, thereby making it easy to see the content of 
the file. 

Show Hierarchically
Groups together files with their embedded content as long as that 
content is stored in Enterprise such as InDesign files with placed articles 
and/or images, or articles that consist of multiple components. An 
expander (� ) will appear in front of such files which can be twirled 
open to show the content, or twirled closed to hide the content from 
view. 

Show/Hide Preview
Choosing Show Preview or Hide Preview opens or closes the Preview 
pane respectively. When selecting a file in the Document pane, a 
preview of the file is shown in the Preview Pane. This could for instance 
be a preview of a layout, an image, or the first 250 characters of an 
article. 

g	 3.8	T he Status bar

The Status Bar at the bottom of the Smart Connection panel shows the 
following information (see figure 11):

nn Dynamic Update status
nn User name and name of the Enterprise server to which you are logged 

in to 
nn Result totals

Dynamic Update status
The Dynamic Update icon (�) is colored orange (   ) when Dynamic Update 
is active, and gray (   ) when the Dynamic Update is not active. (For more 
information about Dynamic Update, see section 3.6.1)

User Name and Name of Enterprise server
The name of the user and the name of the Enterprise server that was logged in 
to (�) is displayed in the following format: [user] @ [Enterprise server].

Results Totals
When locating files using a Search mode in the Search pane, the total number 
of files found is displayed on the far right in the Status bar (�). When the 
results exceed the default maximum of 100 files, the results will be displayed in 
groups of 100. The currently displayed group is also shown. The display format 
is as follows: 

Total [total number of files found] | [first file # of displayed group — 
last file # of displayed group] displayed

When multiple result groups exist, Previous and Next buttons (�) can be used 
to navigate through the groups.
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Refresh
Choosing the Refresh command in the flyout menu is similar to 
clicking the Refresh button in the Search pane. It is used to refresh the 
content of the Document pane. 

Reset Default View
Brings the Smart Connection panel back to its default state (The 
Document pane in List view mode with the Inbox Search active).

Filter
Displays a submenu containing various file types by which the 
Document pane can be filtered. When a file type is selected, only 
files of the selected type are shown in the Document pane (multiple 
selections are possible); when a file type is not selected, such files are 
not shown in the Document pane.  Options are as follows:

nn Layout. InDesign layouts.
nn Article. InCopy articles.
nn Image. Image files.
nn Layout Module. InDesign Layout Modules.
nn Dossier. Dossiers or Job bag
nn Other. All file types other than those listed above. 

New Smart Connection Panel...
Creates a new Smart Connection panel in addition to the one(s) that 
already exist. 

Remove Smart Connection Panel
Removes the current Smart Connection panel.

Rename Smart Connection Panel 
Allows you to rename Smart Connection panels. 

In addition to the nine commands mentioned, newly created Smart 
Connection panels are also listed at the bottom of the flyout menu. This makes 
is easy to bring a Smart Connection panel back into view after hiding it. 
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nn Send Message. (�) Used for sending a message to the designer of the 
layout of which the article is part. 

nn Customise. (�) Used for defining which toolbar buttons should be 
displayed or hidden. 

g	 4.2	C ustomise the Toolbar

In order to hide or display the buttons in the toolbar, do the following:

Step 1. From the flyout menu, choose Customise. The Customise Smart 
Connection Toolbar Controls dialog box appears.

                 

Step 2. Do one of the following:
nn Select a check box to display the button from the toolbar 
nn Clear a check box to hide the button from the toolbar
nn At least one button needs to be selected.

Step 3. Click OK for the changes to take affect or click Cancel to close 
the dialog box without making any changes to the toolbar.

4

A Smart Connection toolbar is added to the InCopy interface and contains 
buttons for easily accessing the often used features Send Article to Next, 
Update Geometry, and Send Message.

The toolbar is accessed by choosing Smart Connection Toolbar from the Smart 
Connection submenu of the Window menu.

For easy access, dock the toolbar in the main toolbar area of the InCopy 
interface, or use it as a floating toolbar close to the area where you are 
working.

This chapter describes in detail how to use the toolbar.

g	 4.1	I nterface

The Smart Connection Toolbar consists of the following components:

                               �      �      �     �

                       
Smart Connection Tool bar

nn Send Article to Next.(�) Used for automatically sending the article 
to the next status in the Workflow. 

nn Update Geometry. (�) Used for automatically updating the article 
with the latest available geometry information. 

Smart Connection Tool bar
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g	 5.1	C omponents

The Resize Text Frame toolbar contains the following components:

                 �                �             �              �       �

         
Figure 12 - Resize Text Frame toolbar

nn X coordinate. (�) The X coordinate value of the text frame that holds 
the article or article component.

nn Y coordinate. (�) The Y coordinate value of the text frame that holds 
the article or article component.

nn Width. (�) The width value of the text frame that holds the article or 
article component.

nn Height. (�) The height value of the text frame that holds the article or 
article component.

nn Flyout menu. (�) Holds commands for adding or removing a line to 
the article or article component.

g	 5.2	U sing the Resize Text Frame Toolbar 

Using the Resize Text Frame toolbar is only possible under the following 
conditions:

When a layout designer places an article on a layout, the location and size of 
the frame that holds the article and its components is stored in the Enterprise 
system. When subsequently opening the article in InCopy, the Resize Text 
Frame toolbar allows you to change the position or size of these text frames.

Changing the text frame properties this way is only possible if your 
administrator has given you sufficient access rights.

The Resize Text Frame toolbar can be accessed by choosing Resize Text 
Frame Toolbar from the Smart Connection submenu of the Window menu.

For easy access, dock the toolbar in the main toolbar area of the InCopy 
interface, or use it as a floating toolbar close to the area where you are 
working.

This chapter covers in detail how to use the Resize Text Frame toolbar.

5 The Resize Text Frame Toolbar
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g	 5.4	C hanging the Text Frame Size

Changing the size of a text frame that holds an article or article component, can 
be done in two ways:

nn By entering exact values. Use this method when you know exactly 
what the size of the frame should be.

nn By adding or removing lines. Use this method when you just want to 
remove or add some space that is equivalent to a line space (leading). 

Each method is described in the following sections.

g	 5.4.1	E ntering Exact Values

To change the size of the text frame that holds the article or article component by 
entering exact values, do the following:

nn Step 1. Place the cursor in the text that is part of the frame that needs to 
be moved.

The current dimensions of the text frame are displayed in the Resize Text Frame 
toolbar.

Although this can be done both in the Galley view as well as in the Layout 
view, we advise to perform this action when in Layout view so that the effect 
in relation to other layout items can be seen.

nn Step 2. In the Resize Text Frame toolbar, change the value of the Width 
and/or the Height.

nn Step 3. To implement the change, do one of the following:
•	 Press the Tab key to tab to another box in the toolbar.
•	 Press Shift+Tab to keep the changed value selected.
•	 Click anywhere in the document.

nn When the opened article is placed on a layout.
When the article is opened together with layout geometry 
information. 

nn When the article is viewed in Galley view or Layout view (not in Story 
view).

nn When you have been given sufficient access rights by your 
administrator.

When the functionality of the Resize Text Frame toolbar is not available, 
the toolbar appears dimmed and no values are displayed:

g	 5.3	  Changing the Text Frame Position

To change the position of the text frame that holds the article or article 
component, do the following:

nn Step 1. Place the cursor in the text that is part of the frame that needs 
to be moved.

The current dimensions of the text frame are displayed in the Resize 
Text Frame toolbar.

Although this can be done both in the Galley view as well as in the Layout 
view, we advise to perform this action when in Layout view so that the 
effect in relation to other layout items can be seen.

nn Step 2. In the Resize Text Frame toolbar, change the value of the X 
coordinate and/or the Y coordinate.

nn Step 3. To implement the change, do one of the following:
•	 Press the Tab key to tab to another box in the toolbar.
•	 Press Shift+Tab to keep the changed value selected.
•	 Click anywhere in the document.
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g	 5.4.2	A dding or Removing Lines

To change the size of the text frame that holds the article or article component 
by adding or removing lines, do the following:

nn Step 1. Place the cursor in the text that is part of the frame that needs 
to be moved.

The current dimensions of the text frame are displayed in the Resize 
Text Frame toolbar.

Although this can be done both in the Galley view as well as in the Layout 
view, we advise to perform this action when in Layout view so that the 
effect in relation to other layout items can be seen.

nn Step 2. From the flyout menu of the Resize Text Frame toolbar, 
choose Add Line to add an extra line, or Remove Line to remove a 
line.
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For detailed information about how to use the Sticky Note tool.

g	 6.2	A  Sticky Note 

The Figure below shows the components of a Sticky Note:

        �               �                  �                 �         �

      

      �              �                               �

nn User Name (�) - Shows the name of the user who created the note.
nn Colored border (�) - Color as assigned to the user by the 

administrator.
nn Creation Date & Time (�) - Date and time when the Sticky Note was 

created (shown in system time’s format).
nn Scrollbar (�) - Use to scroll through the text when the window size is 

too small to show all the text at once.
nn Up/Down buttons (�) - Use to scroll up or down the text line by line 

when the window size is too small to show all the text at once.
nn Resize Handle (�) - Use to change the size of the Sticky Note.

6 Using Sticky Notes

Sticky Notes are short messages that can be placed anywhere in the layout as a 
way of communicating with other users or to act as reminders for yourself. 

This way, you can for instance leave your colleagues instructions about making 
changes to certain content on the layout, or leave yourself reminders on 
changes you want to make yourself.

In InCopy, Sticky Notes can only be displayed and created when in Layout 
View mode.

This chapter describes in detail how to work with Sticky Notes.

g	 6.1	T he Sticky Note Tool

Smart Connection adds a Sticky Note Tool to the InCopy Tools panel with 
which Sticky Notes can be created. The Sticky Note tool is placed after the 
Position tool.

                            � - Sticky note tool

         
The InCopy Toolbar with Sticky Notes tool
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g	 6.4	S ticky Notes in Offline Mode

When logged out from Enterprise and opening an offline article, any Sticky Notes 
that are already part of the layout will appear as unavailable and cannot be edited.

As soon as you log in to Enterprise, these Sticky Notes will automatically become 
available and will be synchronized with any changes that may have been made by 
other users during the time that the document was offline.

It is possible to add new Sticky Notes to the offline article while logged out of 
Enterprise. Of course, these Sticky Notes are fully editable when working on the 
layout offline.

g	 6.5	E diting Sticky Note Content

To edit the text in a Sticky Note, simply place the cursor inside the text area (it is 
not necessary to first select the Type tool).

Editing a Sticky Note is only possible when you have been given sufficient 
privileges by your administrator.

When not logged in, the only Sticky Notes that can be edited are those that 
have been created during this offline period. All other Sticky Notes will 
appear as unavailable.

g	 6.6	R esizing a Sticky Note 

After creating a Sticky Note, it can be resized at any time by doing the following:
nn Step 1. Click and hold the handle bar in the lower right-hand corner of 

the Sticky Note and freely move the mouse pointer. 
nn Step 2. Release the mouse button when the desired size is achieved.

nn Text Area (�) - Area for entering text. Font type, face and size are set 
by default and cannot be changed. 

nn Delete Button (�) - Use to remove the Sticky Note from the layout.

g	 6.3	C reating a Sticky Note

To create a Sticky Note, do the following:
nn Step 1. Make sure that you view the article in Layout View.

nn Step 2. Select the Sticky Note tool in the Tools panel. 
The mouse pointer will change into the Sticky Note icon ().

nn Step 3. Do one of the following:
•	 Click once anywhere on the layout to create a default-size Sticky 

Note.
•	 Click and drag the mouse pointer anywhere on the layout and 

release when the desired size is achieved.

nn Step 4. Click inside the text area to type a message.

Creating a Sticky Note is also possible when not logged in to Enterprise, but 
only on articles that have already been saved to the Enterprise system.

The Sticky Note tool cannot be used when:

nn The article is not part of the Enterprise system
nn The article is opened as Read-only
nn You are viewing the article in Galley view or Story view
nn You have not been given sufficient access rights by your administrator.

Under these scenarios, the Sticky Note icon in the toolbar appears dimmed or 
the mouse pointer appears as the In Use icon (), indicating that no Sticky Note 
can be placed. 
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Deleting a Sticky Note is only possible when you have been given sufficient 
privileges by your administrator.

g	 6.9	S howing or Hiding a Sticky Note

Sticky Notes can sometimes get in the way when working on the layout and can 
therefore be hidden from view. When needed, all Sticky Notes can be displayed 
again. 

To hide all Sticky Notes when in Layout view, do the following:

nn In the View menu, choose Hide Sticky Notes.

To display all hidden Sticky Notes when in Layout view, do the following:

nn In the View menu, choose Show Sticky Notes.

g	 6.10	S ticky Notes as a Messaging Service

One other aspect of Sticky Notes is that it can act as a messaging system. For 
instance: when you add a Sticky Note to an article that is placed on a layout on 
which an InDesign user is currently working, the Sticky Note will appear for the 
InDesign user as soon as you check-in or save a version of the article.

g	 6.11	 Printing or Exporting a Sticky Note

Sticky Notes do not print or export to PDF, irrespective of the viewing modes 
chosen in InCopy.

g	 6.7	R epositioning a Sticky Note 

A Sticky Note can be repositioned at any time, by doing the following:

nn Click and hold either the top or bottom colored border and drag with 
the mouse until the required position is reached.

g	 6.8	D eleting a Sticky Note

It is possible to delete a Sticky Note, but only those that have been added by 
yourself. Sticky Notes that have been added by other users cannot be deleted.
To delete a Sticky Note, do the following:

nn Click the Delete button in the bottom left corner of the Sticky Note. A 
message appears, asking to confirm the action: 

            

Respond to the message as follows:

nn Click Yes to delete the Sticky Note.

nn Click No to close the message and continue working without deleting 
the Sticky Note.  

nn (Optional) Select the check box Don’t Show Again and click Yes. The 
message will not display anymore when next deleting a Sticky Note 
and the Sticky Note will be automatically deleted.
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Take note of the following scenarios that can occur during opening:

The article is already checked-out
In case the article is already checked out by another user, a message 
appears. Respond to the message accordingly

The article has been placed multiple times
In case the article has been placed multiple times on different layouts or 
Layout Modules, a message appears asking you which layout to open:

Respond to the message as follows:
nn Step 1. Select the layout or Layout Module to open. 

nn Step 2. Click OK. 
The article is opened with the layout information of the selected layout 
or Layout Module. Another message appears, this time reminding you 
that changing the content of the article can affect the placement of the 
article on the other layout(s). 

nn Step 3. Click OK to dismiss the message. 
No real action is required, other than being aware that any changes you 
make to the article can have consequences to placed instances of the 
article on the other layout(s).

As an editor using InCopy, you will mostly work on articles that have either 
been created by other editors, or on articles that you may create yourself. If 
an article is already part of a layout, you will be able to see how and where the 
article is placed on that layout so that you can verify how the changes that you 
make affect the overall look and feel of the page.

While working on a placed article, the layout designer using InDesign might 
make changes to the size of the text frame. Since this obviously affects your 
copy fit, the designer can send you this new geometry information, or you can 
check yourself at any time if any changes to the geometry have occurred.

This chapter describes all aspects of working with articles in InCopy.

g	 7.1	O pening an Article

An article stored in Enterprise can be opened in the following ways:

nn Using the Open command. Opens the article as a regular file 
together with layout information.

nn Using the Open Without Design command. Opens the article 
without layout information.

nn In Offline mode. Opens the article that has been taken offline.
nn As Read-only. Opens the article in read-only mode.

Each method is explained in the following sections.

7 Working with Articles
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 g	 7.2 Using the Open Command

Articles stored in Enterprise can only be opened via the Smart Connection 
panel. To open an article, do one of the following:

nn Double-click the article in the Smart Connection panel.

nn Right-click the article in the Smart Connection panel and choose 
Open from the context menu.

The article is checked-out for you (opened for editing) as indicated by the 
yellow pencil icon (   ) that appears for the file in the In Use By column of 
the Document pane in your Smart Connection panel. For all other users, a red 
pencil icon (   ) appears for that file. 

When the article has been placed on a layout, this layout can be viewed in the 
Layout view. This will give you precise information about where in the layout 
the article is placed and is a good way of seeing how any changes you make 
affect the appearance of the article in relation to the design or to other items on 
the page. 

All items on the layout that cannot be edited can be recognized by a crossed-
out pencil icon in the top left corner ( ). As a further indication, these none-
editable items appear dimmed by default, (they can be displayed regularly by 
choosing Undim Noneditable Objects from the View menu.

When opening an article the regular way, the Layout view will display the layout 
on which the article is placed. All layout items that cannot be edited appear 
dimmed and show a slashed pencil icon in the top left hand corner of their frame.
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Each method is explained in the sections on the following pages.

g	 7.3.1	C heck In

When checking in an article, the following actions take place:
nn A version of the article is saved in Enterprise.
nn The article is closed from InCopy.
nn The article is made available to other users for check-out (as indicated 

by the Open For Editing pencil icon that is removed from the Smart 
Connection panel for that article.)

To check-in an article, do the following:

nn Step 1. From the Smart Connection menu, choose Check In... .
The Check In option is only available for articles that have been checked 
out and therefore not to articles that are opened as read-only.

The Check-In dialog box appears.

                    

g	 7.3	C losing or Saving an Article 

Various methods exist for closing an article. Depending on the chosen method, 
any made changes can either be saved or discarded:

nn Check-in. Closes the file, saves all content, creates a new version of 
the file, makes the file available to other users for editing. During 
saving, file properties can be changed.

nn Abort check out. Closes the file, does not save any made changes, 
makes the file available to other users for editing. No file properties 
can be changed.

nn Save version. Saves an intermediate version of the file, file stays open 
for editing. During saving, a limited number of file properties can be 
changed.

nn Save As. Saves the file as a new file, the newly created file is open for 
editing. During saving, file properties can be changed.

nn Take offline. Closes the file, saves the file locally, file stays unavailable 
to other users for editing. No file properties can be changed. 1

nn Close. Same as Check-in, but no version is saved and no file 
properties can be changed.

nn Save Locally. Saves the file locally instead of within the Enterprise 
system.

Using File > Save
When choosing the Save command from the InCopy File menu to save 
an article that is stored in the Enterprise system, the article is saved 
locally and not saved to the Enterprise system. It will only be saved to the 

Enterprise system if you use one of the methods listed above.
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To use the Abort Check Out option, do the following:

nn Step 1. Display the checked-out article on screen.

nn Step 2. From the Smart Connection menu, choose Abort Check Out.
The Abort Check Out option is only available for articles that have been 
checked out and therefore not to articles that are opened as read-only.
Using Abort Checkout is only possible when you have been given 
sufficient access rights by your administrator.

A message appears asking to confirm the action. (See figure 2.2.)

          

nn Step 3. Respond to the message as follows:
•	 Click Yes to close the article without saving any changes
•	 Click No to return to the article without closing it

g	 7.3.3	S ave Version

When using the Save Version option, the following actions take place:

nn An intermediate version of the article is saved. If needed, this version 
can be restored and made as the current version at any time. 

nn The article stays open for editing.

To use the Save Version option, do the following:

nn Step 1. Make at least one change to the article.
nn Step 2. From the Smart Connection menu, choose Save Version... .

In case the article does not yet exist in Enterprise, the Save As dialog box 
appears instead. (For more information, see section 1. Adding an Article to 
Enterprise.)

nn Step 2. (Optional) In the Name box, modify the article name or leave 
the original name.

The settings for Brand, Issue and Category cannot be changed.

The Used In list shows the current layout on which the article is placed and/or 
any Dossiers that the article is part of. 

nn Step 3. From the Status list, choose the status that the article should 
have.

nn Step 4. (Optional) From the Route To list, choose a user or user group 
to whom the file should be routed to.

nn Step 5. (Optional) In the Comment box, add a comment. When a 
user will next open the file, the comment will appear on screen.

nn Step 6. Click OK.

g	 7.3.2 	Abort Check Out

When using the Abort Check Out option, the following actions take place:

nn The article is closed from InCopy and brought back to its original 
state the state it was in when it was opened or last saved using either 
Save Version or File > Save without saving any changes made since the 
last save action and without saving a version of the file.

nn The article is made available to other users for editing (as indicated 
by the Open For Editing pencil icon that is removed from the Smart 
Connection panel for that article.
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comment. When a user will next open the file, the comment will appear 
on screen.

nn Step 7. Click OK.

g	 7.3.4	T ake Offline

Taking an article offline allows you to keep working on the file without being 
logged in to Enterprise (this way, you can for instance work on the file on a laptop 
when being away from the office without a network connection).

When using the Take Offline option, the following actions take place:

nn The article is closed from InCopy. 
nn The article is saved locally.
nn The yellow pencil icon (   ) in the In Use By column in your Smart 

Connection panel changes into a red pencil icon (   ), indicating that 
the file is offline. For all other users, the yellow padlock icon (   ) will 
change into a red padlock icon (   ).

nn The article remains unavailable to other users for editing.

To take an article offline, do the following:

nn Step 1. Display the checked-out article on screen.
nn Step 2. From the Smart Connection menu, choose Close for Offline 

Usage.

The Close for Offline Usage option is only available for articles that have been 
checked out and therefore not to articles that are opened as read-only.

When the command Close for Offline Usage is not present in the menu, you have 
not been given sufficient access rights by your administrator.

The Save Version option is only available for articles that have been 
checked out and therefore not to those that are opened as read-only. 
The command is also not available if no changes have been made to the 

document since the last save action.

The Save dialog box appears. (See below)

        

Since a version of the current file is being saved, only a limited number of 
properties can be changed.

nn Step 3. (Optional) In the Name box, modify the article name or leave 
the original name.

The Used In list shows the current layout on which the article is placed 
and/or any Dossiers that the article is part of. (For more information 
about the Used In list, see chapter 21, Managing the Workflow – section 1, 

The Used In LIst.)

nn Step 4. From the Status list, choose the status that the article should 
have.

nn Step 5. (Optional) From the Route To list, if available, choose a user 
or user group to whom the file should be routed to.

nn Step 6. (Optional) In the Comment box, iof available, add a 
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g	 7.3.5	C lose

When closing an article, the following actions take place:

nn The article is closed from InCopy.
nn The article is made available to other users for check-out (as indicated 

by the Open For Editing pencil icon that is removed from the Smart 
Connection panel for that article).

Note that contrary to the process of checking in an article, no version of the file 
is saved.

To close an article, do the following:

nn Step 1. Use one of the following methods:
•	 From the File menu, choose Close.
•	 Click the Close button of the document window.

If the article does not contain any unsaved changes, the document is closed.

If the article does contain unsaved changes, a message appears:

nn Step 2. Respond to the message as follows:
•	 Click Yes to save the made changes and close the document.
•	 Click Don’t Save to close the document without saving the 

changes.
•	 Click Cancel to return to the article without closing it.

Instead of seeing the message appear, you might see the Check In dialog box 
appear instead, depending on how your administrator has configured the 
system. 
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